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Quick Start Guide 
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This Quick Start Guide shows how to install and configure the Eudora® software. It also 

provides keystroke shortcuts and basic email procedures such as sending and receiving 

messages. 

TIP: The best way to use this Quick Start Guide is to PRINT it and keep by nearby when 

installing, configuring, and using Eudora.

Finding Information

You can find more information about Eudora in the Eudora Email 6.0 User Manual for 

Macintosh. The manual is available in Portable Document Format (PDF) on the Eudora web 

site.

To access the manual

1. Go to the Eudora web site: www.eudora.com.

2. At the top of the page, choose Support (one of the blue boxes).

3. From the list, choose Eudora Manuals.

4. Under Eudora 6.0 for Macintosh, click User Manual.

The Download Manager opens, and an Eudora_Manual.sit file (or similar) is 
transferred to where you download files reside on your Mac.

5. Unstuff the file. 

The pdf manual file appears.

6. Move the manual to the directory of your choice.

The manual topics are linked. When you see a topic associated with a page number in the 

table of contents, index, or cross-reference, click the topic or page number and that topic 

appears.
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If you prefer, you can print the PDF manual. From the File menu in Acrobat Reader, choose 

Print.

If you need help while using Eudora, go to the Help menu.

System Requirements

To use Eudora, you must have at least the following:

• Macintosh® PowerPC processor.

• Macintosh OS 9.0 or later with CarbonLib 1.6 or later. Note that screen graphics that 

appear in this manual may look different if you are using Macintosh OS 9.

• Mac OSX 10.00 or later

• Network or Internet mail account that uses POP3 or IMAP4 protocol.

• Access to your mail account via a TCP/IP (Internet) network connection or via PPP 

dial-up networking through a modem.

Getting Started

Before you can successfully install Eudora, you need to know the following basic information 

about your email account. Either your Internet Service Provider (ISP) or your email 

administrator can provide you with this information.

• Return email address (Return address)

This is the email address that has been assigned to you by your ISP or your 

organization. It is the address other people use to send you email. An example 

return address is jim@myfirm.com

Record your Return address here.
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• User name (Username)

This is the name you use to log into your email account. Your ISP or organization 

provides it. It is generally, but not necessarily, the name that appears before the at 

sign (@) in your return email address (in the example above, "jim" is the user 

name).

Record your Username here.

• Mail account password

This password lets you access your email account. Your ISP or organization 

provides it. Keep this password private. 

• Incoming mail server name (Mail Server)

Your incoming email account resides on a computer at your ISP or within your 

organization. Your incoming mail server name is the Internet server name of that 

computer (for example, pop3mail.myfirm.com).

Record your incoming mail server name (Mail Server name) here.

• POP or IMAP

This is the protocol that your incoming mail server uses. Your incoming mail server 

uses one of the following two Internet protocols, POP or IMAP, for storing and 

forwarding your mail. Ask your ISP or your email administrator which one it uses.

NOTE: If you are setting up an IMAP account, it may require an IMAP Mailbox 

Location Prefix. Obtain this from your ISP or your email administrator. Otherwise, 

leave the following box blank.

If applicable, record your IMAP Mailbox Location Prefix here.
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• Outgoing Mail Server Name

This server, an SMTP server, receives and processes all of your outgoing mail. It 

also resides on a computer at your ISP or within your organization. The server 

name is often the same as your incoming mail server name. Your SMTP server 

name is the full name of that computer, for example, smtp.myfirm.com. If your ISP 

or your email administrator has not given this server name to you, you can leave 

the box blank.

Record your SMTP Server name here (if known).

Installing Eudora

After you have recorded the previous information, you are ready to install, configure, choose 

a Eudora mode, and register your copy of Eudora.

If you are installing over a previous version of Eudora, all of your messages, mailboxes, folders, 

filters, and settings are maintained as long as you install Eudora in the same location as your 

previous version.

To install Eudora

1. Turn off any virus-protection software installed on your computer. Restart your 

Macintosh.

2. If you are installing Eudora from a CD-ROM, insert the Eudora CD into your 

Macintosh CD-ROM drive. If you are installing Eudora from a software archive, 

double-click the archive.

3. Double-click the Eudora 6.0 installer icon to launch the install program.

4. Click Continue in the Installer window, or press Return or Enter.

5. Read the Readme and click Continue. (To save the Readme to a file, click Save. 

To print the Readme, click Print.)

6. Read the Software License Agreement and if you agree to the terms, click Agree. 

The Eudora Install dialog appears.

7. To install Eudora and all of the items listed, choose Custom Install and click 
Install. Custom Install is the default, and it installs all elements of version 6.0. To 

install Eudora only, choose Easy Install. 
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NOTE: It is highly recommended that you update to the most current version of 

QuickTime from Apple’s web site: www.apple.com/quicktime/download.

8. When asked where you want to install the Eudora Application, choose the 

destination folder and click Install. A dialog may appear indicating that your 

Macintosh may need to be restarted following installation.

The install program begins installing the Eudora files into the appropriate locations 
on your disk.

Opening and Configuring Eudora

After you have successfully installed Eudora, you must configure your email account using the 

information you entered in the Getting Started section of this guide. Eudora installs in 

Sponsored mode (with ads) unless you manually enter a Paid mode registration code, or 

unless you have an existing Paid code entered that is valid for this version.

Important. Your older Eudora mailboxes, settings, etc. are used automatically by this most 

current version of Eudora. These files reside either in the System folder or Documents folder 

depending on which Mac OS your system is using. Default location for OS 9 is HD/Documents. 

Default location for OS X is Users/Documents. This folder is named Eudora Folder. Don’t move 

this folder if you want to keep your previous settings. Only the "Application" folder will be 

changed by the Eudora installer.

To open and configure Eudora

1. Go to the Eudora Application Folder and double-click the Eudora application icon 

(unless you installed Eudora 6.0 over an older copy of Eudora, in which case, the 

settings from the older copy are imported automatically into Eudora 6.0).

Eudora launches and the Welcome dialog explaining how Eudora is licensed 
appears.
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Welcome dialog

2. In the Welcome dialog, you can do the following:

• For more information about Eudora’s three modes, click Tell Me More. Also, see 
Operating Eudora in One of Three Modes on page 12.

A web site appears displaying information about Eudora’s three modes of 

operation. 

• To use Eudora in Paid mode with a Paid mode registration number, click Enter 
Code.

A dialog appears for you to enter your registration code.

3. To use Eudora in Sponsored mode, click OK.

The new SpamWatch feature in Eudora 6.0 operates only in Paid mode. A dialog 
appears prompting you to buy Eudora if you want to use the SpamWatch feature.

SpamWatch prompt dialog
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4. In the SpamWatch prompt dialog, do one or both of the following:

• To buy Eudora, click Pay Now.

A web site appears for you to enter registration and payment information.

• To get more information about SpamWatch, click Tell Me More.

A web site appears displaying information about SpamWatch.

5. To continue configuring Eudora in Sponsored mode without SpamWatch, click OK. 

The Import settings and mail dialog appears.

Import setting and mail dialog 

6. If you want to import settings and mail from another email program, click Yes. Other 

dialogs appear prompting you. See Importing from Other Email Programs in the 

Eudora User Manual for more information or go to: 

www.eudora.com/techsupport/mac/

If you don’t want to import settings, click No.

The Getting Started Settings dialog appears.
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Sample Getting Started Settings dialog

To check your settings according to the instructions here, or anytime after 

launching Eudora, choose Settings from the Special menu and click the Getting 
Started category icon in the left column.

7. In the Getting Started Settings dialog, enter the following information (information 

you entered in Getting Started on page 3 of this guide):

• Username 

• Mail Server 

• Real name (your first and last name as you wish it to appear in the sender line 
of your outgoing mail)

• SMTP Server (outgoing mail server name)

• Return address (if it is different from the address you would get if you combine 
your Username and Mail Server, for example, 
username@mailserver.com)

8. When you finish entering this information, click OK to save your changes.
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POP or IMAP

You need to tell Eudora which Internet protocol your incoming mail server uses, as you 

recorded it earlier in this guide.

To choose POP or IMAP

1. From the Special menu, choose Settings.

2. Scroll and choose Checking Mail.

The Checking Mail Settings dialog appears.

Sample Checking Mail Settings dialog 

3. In the Mail Protocol field, click POP or IMAP, depending on what you recorded 

earlier in this guide. (If you are not sure, click POP. You can always change it later.)

NOTE: If you choose the IMAP mail protocol and you recorded an IMAP Mailbox 

Location Prefix earlier in this guide, enter that information in the IMAP Mailbox 

Location Prefix field that appears.

4. To save your changes, click OK.
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SMTP Server Settings (if necessary)

If your SMTP (outgoing) server is on a different computer than your incoming mail server (your 

ISP or email administrator can provide you this information), you need to do the following after 

you have filled in the Getting Started Settings dialog:

To enter SMTP settings

1. From the Special menu, choose Settings.

2. Scroll and choose Sending Mail. 

The Sending Mail Settings dialog appears.

Sending Mail Settings dialog

3. In the Default Domain field, enter the domain name, if any. Leave this field blank 

if you don’t want Eudora to add a default domain to an incomplete address. (So, if 

you enter myfirm.com in this field and you address a message to bill.jones, 

Eudora expands the address as bill.jones@myfirm.com before sending or queuing 

the message.) 

4. In the SMTP Server field, enter the name of your outgoing (SMTP) server if you 

didn’t enter it in the Getting Started dialog. Click OK to save your changes. 
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Once you have configured Eudora, you are ready to begin sending and receiving 

messages. However, you may want to change the Eudora operating mode and 

register your copy of Eudora. (See Operating Eudora in One of Three Modes on 

page 12).

Operating Eudora in One of Three Modes 

You can choose one of three operating modes on how you wish to use Eudora. They are as 

follows:

• Paid mode—This mode provides the full-featured Eudora desktop email client 

without advertising.

• Sponsored mode—This mode provides the full-featured Eudora desktop email 

client at no charge, supported by sponsors' advertising. It includes all of the features 

that are in the Paid mode except for SpamWatch.

• Light mode—This is an upgrade to the freeware version formerly known as Eudora 

Light. It includes fewer features than the other modes and may include a sponsor 

image or logo, but no advertising.

Choosing a Eudora Mode

If you would like to change the operating mode, for example to Sponsored mode, you can do 

so right in the Eudora program. 

To change the Eudora operating mode after you install Eudora 6.0

1. From the Help menu, choose Payment & Registration. 

The Payment and Registration window appears.
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Payment and Registration window

2. In the Which Eudora is right for you? section: 

• To use Eudora in Sponsored mode, click Sponsored Mode (free, with ads).

Eudora displays the ad window. 

• To use Eudora in Paid mode, click Paid Mode (costs money, no ads). 

Eudora displays the Eudora web site for you to purchase Eudora.

• To use Eudora in Light mode, click Light Mode (free, fewer features). 

Eudora changes to Light mode by shutting down certain features. The features 

that will be turned off are listed in the confirmation dialog.

3. In the Keeping Current section:

• To register, click Register with Us.

Eudora displays a web site where you can enter registration information. See 

the next section for more information.

• To add or change your profile, click Profile.

Eudora displays a web site where you can provide information about yourself to 

help in customizing which ads would be of interest to you.

• To find the most current version of Eudora, click Find the Latest Versions.

The Eudora web site displays where you can retrieve the latest version of 

Eudora and lets you know if there is a cost to upgrade.
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NOTE: The grayed out button indicates the mode in which you are operating 

Eudora. For more information about the modes, click Go to the Eudora web site 
for more information.

4. Exit the dialog box.

Registering Eudora

If you are using Eudora in Paid mode, you need to register to be eligible for technical support. 

Also, you need to be registered to upgrade to a newer version of Eudora and stay in Paid 

mode. If you don’t register or you use Eudora in Sponsored or Light mode, you are not eligible 

for technical support.

To register your copy of Eudora

1. From the Help menu, choose Payment & Registration. 

The Payment and Registration window appears.

2. In the Keeping Current section, click Register with Us. 

Eudora takes you to Eudora s registration web page.

3. Enter your information, click Submit Registration. 

You receive an email confirming your registration. 

Technical Support 

If after reviewing all of the available materials the user manual, this Quick Start Guide, the 

README files, the Online Help, and you still need help, contact your ISP or email administrator 

or the Eudora Technical Support group.

Before you call technical support, you need to register your copy of Eudora in Paid mode. Be 

sure to register as soon as possible to avoid any delays in receiving technical support.

For a quick introduction to Eudora’s basic functions, refer to the procedures provided in this 

guide and to your online help, which you can access from the Eudora Help menu.
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Many common issues can be solved by visiting the Eudora technical support web site 

www.eudora.com/techsupport/Mac. The technical support web site provides online answers 

to your technical questions about QUALCOMM’s Eudora software products. Go to the 

Technical Support web site to get valuable “how to” information and step-by-step interactive 

tutorials www.eudora.com/techsupport/tutorials.

Also, you will be able to retrieve most current Eudora products and documentation. 

(Sponsored and Light mode users may use the Eudora web site technical support and 

tutorials.)

If you are unable to find your answer using the technical support web site, Eudora tech support 

reps are available Monday - Friday from 8 a.m. to 5 p.m. Pacific Time using the following phone 

number and email address:

Phone: (858) 658-1292 (Paid mode users only)

Person to person support is available to the Paid mode user who has a valid registration code.

Email: eudora-support@qualcomm.com (Paid mode users only)

When sending email, make sure to include your Paid Mode registration code in the Subject 

field or in the body of your message.
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Creating and Sending a Message

Writing and sending a message

1. From the Message menu, choose New Message.

2. Type an email address in the To field.

3. Press Tab to move the cursor to the Subject field.

4. Type the subject of your message (optional, but recommended).

5. Press Tab and type in the Cc field email address (optional).

6. Press Tab and type in the Bcc field email address (optional).

7. Press Tab and type in the body of the message.

8. After completing the message, click Send.

TIP: You can type multiple addresses in the To, Cc, and Bcc fields, as long as you separate 

them with commas.

Also, you can save a message without sending it by selecting Save from the File menu. Your 

message is saved in the Out mailbox. It can be reopened and edited at any time prior to 

sending it.

Checking for and Receiving Mail

You can manually check for mail or set up Eudora to automatically check for mail.

Checking mail manually

1. From the File menu, choose Check Mail.

2. If Eudora asks for your password, type it in the Password dialog and click OK 

(server passwords are usually case-sensitive).

3.  If there is no mail for you, a "no mail" alert appears. Click OK.

4. If you have new mail, Eudora transfers the messages one by one and then displays 

a "new mail" alert. Click OK.

5. New messages are delivered to your In mailbox. This mailbox opens automatically 

and your new message summaries are added to the end of the mailbox list. 
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6. Double-click a message summary to open the message or read the message in the 

preview pane.

Checking mail automatically

1. From the Special menu, choose Settings. Then, click the Checking Mail category 

icon.

2. Click the checkbox for Check for mail every ___ minutes to turn on automatic 

mail checking. In the text box, type the number of minutes between automatic mail 

checks (15 is the recommended interval).

3. To save your changes and close the Settings dialog, click OK.

Eudora automatically checks for mail at the interval you have requested.

Replying to a Message

To reply to a message

1. Choose or open the message you want to reply to.

2. From the Message menu, choose Reply to display a new composition window. 

Eudora completes the To, From, and Subject fields based on the original message.

3. Remove those parts of the original text that you don’t want to include in your reply 

and type in your own text.

4. When you finish your response, click Send.

Forwarding a Message

To forward a message

1. Choose or open the message you want to forward.

2. From the Message menu, choose Forward to display a new composition window. 

Eudora completes the Subject field based on the original message and transfers 

the header and body of the original message to the new message body.

3. Type the addresses of the people you want to forward the message to in the To 

field.

4. The existing text may be edited, and more text may be added to the message.
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5. After editing the message, click Send to forward it.

Redirecting a Message

Eudora’s Redirect command lets you pass on a received message that was intended for 

someone else, allowing that person to reply directly to the original sender.

To redirect a message

1. Choose or open the message you want to redirect.

2. From the Message menu, choose Redirect to display a new composition window.

Eudora completes the From field with the address of the originator, followed in 
parentheses by the words "by way of" and your name and/or email address. The 
Subject field and message body are also completed based on the original 
message.

3. Type the addresses of the people to whom you wish to redirect the message in the 

To field.

4. The existing text may be edited, and more text may be added to the message.

5. Once the editing is completed, click Send.

NOTE: Email courtesy suggests that you not do much editing of the message you’re 

redirecting. If you must add comments, put them in brackets [ ] with your initials, like this: [Don: 

Please reply to this right away. SD]
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Shortcuts

The shortcut keys for Eudora functions are the following:

Press these keys This will happen...

Command + . Stops the current action

Command + 0 Opens Out mailbox

Command + 1 Opens In mailbox)

Command + 6 Checks spelling 

Option + Command + 6 Finds next misspelling

Shift + Option +  
Command + 6

Adds word to dictionary

Command + - Sends queued messages

Command + = Enter selection (into Find window)

Command + \ Sends to back (move current window to the back of all Eudora windows)

Command + ’ Adds one level of excerpt bars

Command + Option + ’ Removes one level of excerpt bars

Command + , Finishes address book entry (finish nickname)

Command + [ Lowers priority

Command + ] Raises priority

Command + A Selects all

Command + Shift + A OS X only - Attaches document... (attach a file to a message)

Command + B Makes the selected text bold

Command + C Copies

Command + D Deletes messages

Command + E Sends immediately, or queues for delivery

Command + F Finds (open the Find window to search for a text string in the current message)

Option + Command + F Searches for messages in mailboxes and folders

Command + G Finds again 

Command + H OS 9 - Attaches document... (attach a file to a message). OS X hides Eudora

Command + I Makes the selected text italic

Command + J Filters messages (execute manual filters on the selected messages) OR transfer Junk 
mail messages
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Command + K Makes address book entry... (make nickname)

Command + L Opens address book

Command + M Checks mail

Command + N Creates a new message

Command + O Opens file

Command + P Prints

Command + Q Quits Eudora

Command + R Replies to messages

Command + S Saves

Command + T Makes the selected text plain

Command + U Makes the selected text underlined

Command + V Pastes

Command + W Closes the window or message

Command + X Cuts

Command + Y Opens Directory Services

Command + Z Undo/Redo

Arrows Moves from one message to another in a mailbox (depends on your Moving Around 
Settings)

Command + Arrows Moves from one file to another in the address book

Return or Enter Selects the outlined button in any dialog, alert, or window, or opens the selected 
message(s)

Spacebar Opens a selected message summary (or scrolls its preview down through the message 
preview panel), or closes the current open message. For long open messages, scrolls 
the message down one page

Esc Stops any operation currently in progress

Help OS 9 only - Turns balloon help on or off

F1 Undo/Redo, or main toolbar function

F2 Cuts, or main toolbar function

F3 Copies, or main toolbar function

F4 Pastes, or main toolbar function

Home Scrolls the window to the beginning

End Scrolls the window to the end

Press these keys This will happen...
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Note. Function keys can be linked to main toolbar buttons by turning on the Map function keys 

to buttons option in the Toolbar Settings (Special>Settings...>Toolbar).

© 2003 QUALCOMM Incorporated, San Diego, CA 92121. All rights reserved.  

QUALCOMM, Eudora, Eudora Pro, Eudora Light, and QChat are registered trademarks of 

QUALCOMM Incorporated.

PureVoice, SmartRate, MoodWatch, WorldMail, and the Eudora logo are trademarks of 

QUALCOMM Incorporated.

QuickTime is a trademark of Apple Computer, Inc. QuickTime is a trademark used under 

license, registered in the U.S. and other countries. All other trademarks are property of their 

respective owners. 

Export of this technology may be controlled by the United States Government. Diversion 

contrary to U.S. law prohibited.

September 2003 

80-48494-2 Rev A

Page Up, Page Down Scrolls up or down through the window one page a time

Press these keys This will happen...
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